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NO.1 A customer wants to increase the throughput of their inserts. They have discovered that the
bottleneck is in the storage I/Os of their environment. What should they do to remove this
bottleneck?
A. Remove any non-JSON data from the database.
B. Ask Support to migrate their setup to a node without noisy neighbors.
C. Increase the number of OCPUs allocated to the database.
D. Run the DBMS_CLOUD.INCREASE_THROUGHPUT procedure.
Answer: C
Explanation:
Addressing a storage I/O bottleneck for insert throughput in Autonomous Database involves resource
adjustments:
Correct Answer (C): "Increase the number of OCPUs allocated to the database" boosts processing
power, which directly improves I/O performance. In Autonomous Database, OCPUs handle both
compute and I/O operations; more OCPUs increase the I/O bandwidth, reducing the bottleneck for
insert-heavy workloads.
Incorrect Options:
A: Removing non-JSON data may optimize storage use but doesn't directly address I/O throughput for
inserts.
B: "Noisy neighbors" is a shared infrastructure concern, but migration isn't a standard solution for I/O
bottlenecks and requires Oracle intervention, not user control.
D: There is no DBMS_CLOUD.INCREASE_THROUGHPUT procedure; this is a fabricated option.
Scaling OCPUs is the most effective user-controlled solution.

NO.2 A Business Analyst joined your organization and wants to explore the database tools. When
restoring or cloning an Autonomous Database (ADB), you must select a backup that is at least how
old?
A. 24 hours
B. 5 minutes
C. 2 hours
D. 1 day
Answer: A
Explanation:
Full Detailed In-Depth Explanation:
When restoring or cloning an Autonomous Database (ADB), Oracle enforces a minimum backup age
to ensure data consistency and integrity. The official Oracle documentation specifies that backups
used for these operations must be at least 24 hours old. This requirement exists because:
Backups need time to complete and stabilize, ensuring all transactions are fully committed and the
backup is consistent.
Recent backups (e.g., less than 24 hours old) may still be in progress or lack full verification, risking
incomplete or corrupted restores/clones.
Options B (5 minutes), C (2 hours), and D (1 day) are either too short or redundant:
5 minutes and 2 hours: Too recent, violating the 24-hour rule.
1 day: Matches 24 hours but is less precise than the explicit "24 hours" phrasing in the
documentation.
For the Business Analyst's exploration, they can access tools like SQL Developer Web or Data Load via
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the OCI Console under the "Tools" tab, but this question focuses on the backup age constraint,
making A the best answer.

NO.3 Which two infrastructure types support deployment of Oracle Autonomous Database? (Choose
two.)
A. Virtual Machines on Oracle Cloud Infrastructure
B. Dedicated Exadata Infrastructure
C. Oracle Bare Metal Servers
D. Shared Exadata Infrastructure
Answer: B,D
Explanation:
Oracle Autonomous Database is designed to run on specific infrastructure optimized for its managed
capabilities:
Correct Answer (B): Dedicated Exadata Infrastructure provides a fully dedicated Exadata system for a
single tenant, offering maximum isolation, performance, and customization (e.g., maintenance
scheduling).
Correct Answer (D): Shared Exadata Infrastructure allows multiple Autonomous Database instances
to share Exadata resources, providing a cost-effective option for smaller workloads while retaining
automation benefits.
Incorrect Options:
A: Virtual Machines (VMs) on OCI are not a supported deployment platform for Autonomous
Database. It requires Exadata hardware for its self-managing features, unlike traditional OCI VMs
used for manual database setups.
C: Oracle Bare Metal Servers are not used for Autonomous Database; they lack the specialized
Exadata architecture needed for its autonomous operations.
These infrastructure types ensure high performance and scalability tailored to Autonomous
Database's requirements.

NO.4 Which command can you use to create an Autonomous Database?
A. POST /20160918/createADB
B. POST /20160918/createautonomousDatabases
C. POST /20160918/createDatabases
D. POST /20160918/autonomousDatabases
Answer: D
Explanation:
Creating an Autonomous Database (ADB) via OCI's REST API involves a specific endpoint. The correct
command is:
POST /20160918/autonomousDatabases (D): This is the official REST API endpoint to create an ADB
instance. The POST request to /20160918/autonomousDatabases (versioned at API 20160918)
submits a JSON payload defining the database (e.g., compartment, name, workload type). Example:
curl -X POST "https://database.us-ashburn-1.oraclecloud.com/20160918/autonomousDatabases" \
-H "Authorization: Bearer <token>" \
-H "Content-Type: application/json" \
-d '{
"compartmentId": "ocid1.compartment.oc1..example",
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"dbName": "MYADB",
"cpuCoreCount": 1,
"dataStorageSizeInTBs": 1,
"dbWorkload": "OLTP",
"adminPassword": "Secure#123"
}'
This creates an ATP instance named MYADB with 1 OCPU and 1 TB storage. The response includes an
OCID (e.g., ocid1.autonomousdatabase.oc1..example), and provisioning starts asynchronously, visible
in the OCI console as "PROVISIONING." The endpoint's plural form (autonomousDatabases) reflects
the resource collection, consistent with OCI API conventions.
The incorrect options are:
POST /20160918/createADB (A): No such endpoint exists. OCI APIs use resource-based paths (e.g.,
/autonomousDatabases), not action-specific ones like createADB.
POST /20160918/createautonomousDatabases (B): Incorrect syntax-APIs don't prepend "create" to
resource paths, and "autonomousDatabases" is lowercase here, matching the real endpoint.
POST /20160918/createDatabases (C): Too generic; it doesn't specify "autonomous" databases, and
no such endpoint exists for ADB creation.
This REST command is a programmatic alternative to console-based provisioning, ideal for
automation.

NO.5 In the Autonomous Database on Dedicated Infrastructure service, what does the fleet
administrator use to control OCPU utilization?
A. Oracle Machine Learning notebook
B. Compartment quotas
C. SQL Developer Web Console
D. Resource Manager settings
Answer: B
Explanation:
Fleet administrators manage resource utilization in Autonomous Database on Dedicated
Infrastructure:
Correct Answer (B): Compartment quotas are used to set limits on OCPU usage across multiple
database instances within a compartment. This OCI feature allows administrators to define maximum
resource allocations, ensuring efficient use and cost control at a tenancy level.
Incorrect Options:
A: Oracle Machine Learning notebooks are for analytics, not resource control.
C: SQL Developer Web Console manages individual database tasks, not fleet-wide OCPU limits.
D: Resource Manager settings apply to individual instances, not fleet-level quotas.
Compartments provide a scalable, tenancy-wide control mechanism.

NO.6 Which statement is FALSE about Data Insights?
A. Data Insights display information about patterns and anomalies in the data of entities in your
Oracle Autonomous Database
B. Data Insights provides a wide range of graphical data presentation capabilities
C. Data Insights are automatically generated by various analytic functions built into the database
D. The results of the Insight analysis appear as a series of bar charts in the Data Insights dashboard
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Answer: C
Explanation:
Data Insights is a feature in Autonomous Database that helps users understand their data. The false
statement is:
Data Insights are automatically generated by various analytic functions built into the database (C):
This is incorrect. Data Insights are not solely the result of automatic execution of built-in analytic
functions (e.g., AVG, SUM, or RANK). Instead, they are generated through a combination of user-
initiated analysis and Oracle's machine learning-driven capabilities within the Data Insights
dashboard (part of Database Actions or OCI console). Users select datasets or tables, and the system
applies algorithms to identify patterns (e.g., trends in sales) or anomalies (e.g., outlier transactions),
but this process isn't just a passive outcome of pre-existing database functions-it's an active, curated
feature requiring configuration. For example, a user might explore a SALES table, and Data Insights
highlights a spike in Q4 sales, but this requires user input to define scope, not just automatic function
output.
The true statements are:
Data Insights display information about patterns and anomalies in the data of entities in your Oracle
Autonomous Database (A): True. The feature visualizes trends (e.g., seasonal sales increases) and
outliers (e.g., unexpected data drops) in tables or views, helping users spot significant data behaviors.
For instance, it might show a bar chart of monthly revenue with an anomaly flagged for a sudden dip.
Data Insights provides a wide range of graphical data presentation capabilities (B): True. It offers
visualizations like bar charts, line graphs, and scatter plots, customizable to represent data insights
effectively. E.g., a line graph might track customer sign-ups over time, with options to adjust axes or
filters.
The results of the Insight analysis appear as a series of bar charts in the Data Insights dashboard (D):
True, partially. While bar charts are a common default (e.g., comparing sales by region), the
dashboard supports multiple chart types, but the statement's focus on bar charts aligns with typical
output for simple insights.
The misconception in C overlooks the interactive, ML-assisted nature of Data Insights, distinguishing
it from passive function-based analytics.

NO.7 Where can a user's public SSH key be added on the Oracle Cloud Infrastructure Console in
order to execute API calls?
A. On the Autonomous Database Console
B. SSH keys are not required in Oracle Cloud Infrastructure
C. SSH keys cannot be added from console. They have to be added using REST APIs only
D. Navigate to Identity, select Users panel on the console and select "Add Public Key"
Answer: D
Explanation:
SSH keys in OCI are used for secure access, but their role in API calls needs clarification. The correct
answer is:
Navigate to Identity, select Users panel on the console and select "Add Public Key" (D): This is the
correct process, but with a caveat-it's about API authentication, not SSH for API calls per se. In OCI,
API calls are authenticated using API keys (RSA key pairs), not SSH keys directly. To enable API access
for a user, you generate a public/private key pair (e.g., using openssl), then add the public key in the
OCI console:
Go to "Identity & Security" > "Users."
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Select the user (e.g., john.doe).
Under "API Keys," click "Add API Key."
Upload the public key (e.g., ~/.oci/oci_api_key_public.pem).
This associates the key with the user, allowing API calls (e.g., oci db autonomous-database list)
authenticated via the private key and config file (e.g., ~/.oci/config). The question's phrasing ("SSH
key") likely misuses terminology, intending "API key," as SSH keys are for compute instance access,
not APIs. For example, a user might add a key to call the ADB API, securing requests with a signature.
The incorrect options are:
On the Autonomous Database Console (A): The ADB console manages database-specific settings (e.g.,
wallets), not user API keys, which are handled at the tenancy level under Identity.
SSH keys are not required in Oracle Cloud Infrastructure (B): False in general-SSH keys are needed for
compute instances-but misleading here, as API calls use API keys, not SSH keys. Authentication (e.g.,
via tokens or keys) is required for APIs.
SSH keys cannot be added from console. They have to be added using REST APIs only (C): False. The
console supports adding API keys under the Users panel; REST APIs (e.g., CreateApiKey) are an
alternative, not the only method.
The correct path reflects OCI's user management for API access, despite the SSH terminology
confusion.

NO.8 Which predefined service connection should you use when running lots of high concurrent
queries in an Autonomous Database?
A. DBNAME_LOW
B. DBNAME_MEDIUM
C. DBNAME_HIGH
D. DBNAME_CONCURRENT
Answer: A
Explanation:
Full Detailed In-Depth Explanation:
Service connections in Autonomous Database:
A . DBNAME_LOW: Optimized for high concurrency with minimal resources per query, ideal for many
simultaneous queries.
B . DBNAME_MEDIUM: Balanced concurrency and performance.
C . DBNAME_HIGH: Prioritizes individual query performance, not concurrency.
D . DBNAME_CONCURRENT: Not a valid service name.

NO.9 Data Guard is enabled for your Autonomous Database and the Lifecycle State field for the
primary database indicates that it is Stopped. Which statement is true?
A. Switchover is automatically initiated.
B. Standby database is terminated.
C. Standby database is also stopped.
D. Failover is automatically initiated.
Answer: C
Explanation:
With Autonomous Data Guard enabled, the primary and standby databases are tightly coupled:
Correct Answer (C): "Standby database is also stopped" is true. When the primary database is
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stopped (e.g., via OCI Console), the standby database is also stopped to maintain consistency and
alignment between the two. This ensures the standby remains a viable replica when the primary
restarts.
Incorrect Options:
A: Switchover (role reversal) requires manual initiation and an active primary; it doesn't occur
automatically on stop.
B: The standby is not terminated; it remains configured but stopped.
D: Failover (standby promotion) is not automatic on a planned stop; it's triggered only by primary
failure.
This behavior preserves Data Guard functionality.

NO.10 You see a clock icon in the Status column on the SQL Monitoring tab of Performance Hub.
What does it indicate?
A. The SQL statement is queued.
B. The SQL statement is executing.
C. The SQL statement did not complete either due to an error.
D. The SQL statement completed its execution.
Answer: A
Explanation:
The Performance Hub in Autonomous Database provides real-time SQL monitoring with status
indicators:
Correct Answer (A): A clock icon in the Status column indicates "The SQL statement is queued." This
means the statement is waiting in a queue (e.g., due to resource limits or consumer group settings)
and has not yet started executing.
Incorrect Options:
B: An executing statement typically shows a green progress bar or running icon, not a clock.
C: An error would display a red icon or error symbol, often with details in the UI.
D: A completed statement shows a checkmark or similar success indicator.
This visual cue helps identify resource contention or scheduling delays.

NO.11 When you are increasing the number of OCPUs in your Autonomous Database, what does its
status show?
A. UPSCALE IN PROGRESS
B. RESIZING IN PROGRESS
C. UPLIFT IN PROGRESS
D. SCALING IN PROGRESS
Answer: D
Explanation:
Scaling OCPUs in an Autonomous Database triggers a specific status update. The correct answer is:
SCALING IN PROGRESS (D): When you increase (or decrease) the number of OCPUs, the database
status in the OCI console changes to "SCALING IN PROGRESS." This indicates that the system is
actively adjusting the compute resources, a process that typically completes in a few minutes with no
downtime for active transactions.
The incorrect options are:
UPSCALE IN PROGRESS (A): "Upscale" is not an official status term used by Oracle for this operation.
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RESIZING IN PROGRESS (B): While "resizing" might intuitively fit, Oracle specifically uses "SCALING IN
PROGRESS" for CPU adjustments.
UPLIFT IN PROGRESS (C): "Uplift" is not a recognized status in the context of Autonomous Database
scaling.
This status reflects Oracle's terminology for dynamic scaling.

NO.12 Which three methods can be used to migrate your existing Oracle database to Autonomous
Database? (Choose three.)
A. Using SFTP to copy CSV files into an Autonomous Database
B. Using Oracle Zero Downtime Migration (ZDM)
C. Using GoldenGate
D. Using Data Pump
E. Using Recovery Manager (RMAN)
Answer: B,C,D
Explanation:
Migrating to Autonomous Database requires robust tools:
Correct Answer (B): Oracle Zero Downtime Migration (ZDM) minimizes downtime by synchronizing
data and schema changes while the source remains online, ideal for critical systems.
Correct Answer (C): GoldenGate provides real-time replication, enabling near-zero downtime
migration by continuously syncing data to Autonomous Database.
Correct Answer (D): Data Pump exports data and schema to dump files, which are then imported into
Autonomous Database, suitable for offline migrations.
Incorrect Options:
A: SFTP with CSV files is not a comprehensive migration method; it lacks schema migration and
automation for complex databases.
E: RMAN is for backup/restore, not optimized for full migrations to Autonomous Database's managed
environment.
These methods cater to different migration needs (online vs. offline).

NO.13 Which method does NOT permit you to change the database ADMIN user's password of an
Oracle Autonomous Database on Shared Infrastructure?
A. Admin page of the Cloud Service Console
B. OCI CLI
C. OS command line from the database server
D. SQL Developer
Answer: C
Explanation:
Changing the ADMIN user's password in an Autonomous Database on Shared Infrastructure is
restricted to specific managed methods due to its serverless nature:
Correct Answer (C): "OS command line from the database server" is not permitted because
Autonomous Database is fully managed by Oracle. Users do not have direct access to the underlying
operating system or server, eliminating this as a viable option.
Valid Methods:
A: The Admin page in the OCI Console allows password changes via the "Change Administrator
Password" option, a user-friendly GUI method.

IT Certification Guaranteed, The Easy Way!

8

High Pass Rate 1Z0-931-25 Exam Guide - 1Z0-931-25 Latest Practice Dumps

1Z0-931-25 exam guide,  1Z0-931-25 latest practice dumps,  1Z0-931-25 training practice
https://pass4sure.pdfbraindumps.com/1Z0-931-25_valid-braindumps.html

https://pass4sure.pdfbraindumps.com/1Z0-931-25_valid-braindumps.html


B: The OCI CLI supports password updates using commands like oci db autonomous-database update
with the --admin-password parameter.
D: SQL Developer can change the password using an ALTER USER ADMIN IDENTIFIED BY
<new_password> command, provided the user has appropriate credentials.
This restriction ensures security and consistency in a managed environment.

NO.14 What two actions can you do when a refreshable clone passes the refresh time limit? (Choose
two.)
A. You can manually refresh the clone
B. You can disconnect from the source to make the database a read/write database
C. You can use the instance as a read-only database
D. You can extend the refresh time limit
Answer: B,C
Explanation:
A refreshable clone in Autonomous Database is a read-only copy of a source database that syncs
periodically, but it has a refresh time limit (typically 7 days). Once this limit is exceeded, specific
actions are available. The two correct options are:
You can disconnect from the source to make the database a read/write database (B): After the
refresh time limit passes, the clone can no longer sync with the source. You can "disconnect" it (via
the OCI console or API, e.g., oci db autonomous-database update --is-refreshable-clone false),
converting it into an independent, read/write Autonomous Database. This requires a new license and
incurs full costs, but it allows modifications (e.g., INSERT or UPDATE) that were blocked in read-only
mode. For example, a test clone might be disconnected to become a production instance after
testing.
You can use the instance as a read-only database (C): Even after the refresh limit, the clone remains
functional as a read-only database, retaining its last refreshed state. You can query it (e.g., SELECT *
FROM sales) for analysis or reporting without further refreshes, though it won't reflect source
updates. This is useful if ongoing read-only access suffices without needing write capabilities.
The incorrect options are:
You can manually refresh the clone (A): False. Once the refresh time limit (e.g., 7 days) is exceeded,
manual refreshes are not possible. The clone's refresh capability expires, and it can't sync again
unless recreated. This is a fixed constraint to manage resource usage in ADB.
You can extend the refresh time limit (D): False. The refresh period (set during clone creation, max 7
days) cannot be extended after provisioning. You'd need to create a new clone with a longer limit if
needed, but post-expiry, no extension is allowed.
These options provide flexibility post-expiry, balancing read-only continuity and full database
conversion.

NO.15 Which two statements are true about accessing the Autonomous Database Tools?
A. Database Actions is accessible from a server running on the same virtual cloud network (VCN)
when the Autonomous Database is configured with Private Endpoint networking.
B. Oracle APEX can be accessed only from the Developer menu in the Service Console.
C. Oracle Machine Learning is available only with Autonomous Data Warehouse (ADW) Database.
D. Access to Database Actions is available for all users of Autonomous Database.
E. SQL Developer Web is exclusive to Autonomous Database, not traditional Oracle databases.
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Answer: B,E
Explanation:
Full Detailed In-Depth Explanation:
Since only four options are provided but the format requests two answers, I'll assume E from a prior
question context. Let's evaluate:
A: True but conditional. Database Actions is accessible with a Private Endpoint, but requires proper
network setup (e.g., VCN peering), not guaranteed by default.
B: True. Oracle APEX is accessed exclusively via the "Developer" menu in the Service Console, not
other interfaces.
C: False. Oracle Machine Learning (OML) is available in both ADW and ATP, not just ADW.
D: False. Database Actions access requires specific user privileges (e.g., DWROLE), not granted to all
users by default.
E (assumed): True. SQL Developer Web is exclusive to Autonomous Database, not traditional Oracle
databases.
B and E are the most definitively true statements per documentation.
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